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MOST Compliance Test Application—At a Glance
The Keysight N6466A/N6466B MOST Compliance Test Application is a MOST test 
solution that covers the electrical timing parameters for MOST 150 coax, MOST 
150 optical, and MOST 50 specifications.

The MOST Compliance Test Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Allows you to determine the number of trials for each test.

• Provides detailed information of each test that has been run. The result of 
maximum 64 worst trials can be displayed at any one time.

• Creates a printable HTML report of the tests that have been run. This report 
includes pass/fail limits, margin analysis, and screen shots.

Required
Equipment and

Software

In order to run the MOST automated tests, you need the following equipment and 
software:

• For the minimum version of Infiniium oscilloscope software, see the 
N6466A/N6466B release notes.

• N6466A/N6466B MOST Compliance Test Application software and license.

• Probe:

• For electrical test, you can use one of the following oscilloscope probes:

• N2750A InfiniiMode 1.5 GHz active differential probe (with 0.1" header 
socketed tip, solder-in tip, or browser tip).

• 1130A InfiniiMax1.5 GHz differential probe amplifier and probe head (for 
example, E2678A socketed probe head with damping resistor).

• For optical testing, an optical-to-electrical converter (OEC) is required. 
Keysight does not sell OECs, but you can get them from other vendors.

MOST150o SP2 extinction ratio testing requires a DC-coupled OEC. 
Graviton, for example, is a vendor who sells a DC-coupled optical probe.

All other optical tests can use either an AC-coupled or a DC-coupled optical 
probe. Keysight has tested using the AC-coupled Hamamatsu C5658 
optical-to-electrical converter.

• Infiniium 9000 Series or 90000 Series oscilloscope.
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1 Installing the MOST 
Compliance Test Application

Installing the Software / 10
Installing the License Key / 11

If you purchased the N6466A/N6466B MOST Compliance Test Application 
separate from your Infiniium oscilloscope, you need to install the software and 
license key.
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1 Installing the MOST Compliance Test Application
 

Installing the Software

1 Make sure you have the minimum version of Infiniium oscilloscope software 
(see the N6466A/N6466B release notes) by choosing Help > About Infiniium... 
from the main menu.

2 To obtain the MOST Compliance Test Application, go to Keysight website: 
"http://www.keysight.com/find/MOST"

3 The link for MOST Compliance Test Application will appear. Double-click on it 
and follow the instructions to download and install the application software..

http://www.keysight.com/find/MOST


Installing the MOST Compliance Test Application 1
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Installing the License Key

1 Request a license code from Keysight by following the instructions on the 
Entitlement Certificate.

You will need the oscilloscope's "Option ID Number", which you can find in the 
Help > About Infiniium... dialog box.

2 After you receive your license code from Keysight, choose Util ities > Install Option 
License....

3 In the Install Option License dialog, enter your license code and click Install 
License.

4 Click OK in the dialog that tells you to restart the Infiniium oscilloscope 
application software to complete the license installation.

5 Click Close to close the Install Option License dialog.

6 Choose File > Exit.

7 Restart the Infiniium oscilloscope application software to complete the license 
installation.
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1 Installing the MOST Compliance Test Application
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2 Preparing to Take 
Measurements

Calibrating the Oscilloscope / 14
Starting the MOST Compliance Test Application / 15

Before running the MOST automated tests, you should calibrate the oscilloscope 
and probe. No test fixture is required for this application. After the oscilloscope and 
probe have been calibrated, you are ready to start the MOST Compliance Test 
Application and perform the measurements.
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2 Preparing to Take Measurements
 

Calibrating the Oscilloscope

If you haven't already calibrated the oscilloscope, see Appendix A, “Calibrating the 
Infiniium Oscilloscope and Probe,” starting on page 71.

NOTE If the ambient temperature changes more than 5 degrees Celsius from the calibration 
temperature, internal calibration should be performed again. The delta between the 
calibration temperature and the present operating temperature is shown in the Util ities > 
Calibration menu.

NOTE If you switch cables between channels or other oscilloscopes, it is necessary to perform cable 
and probe calibration again. Keysight recommends that, once calibration is performed, you 
label the cables with the channel on which they were calibrated.
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Starting the MOST Compliance Test Application

1 Ensure that the MOST Device Under Test (DUT) is operating and set to desired 
test modes.

2 To start the MOST Compliance Test Application: From the Infiniium 
oscilloscope's main menu, choose Analyze > Automated Test Apps > 
N6466A/N6466B MOST Test App.

The task flow pane, and the tabs in the main pane, show the steps you take in 
running the automated tests:

Figure 1 MOST Compliance Test Application Main Window
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2 Preparing to Take Measurements
 

Set Up Lets you identify and set up the test environment, including information 
about the device under test.
The Device Identifier, User Description, and Comments are all printed in 
the final HTML report.
Select the Most specification to be tested:
• MOST150c for MOST150 cable.
• MOST150o for MOST150 optical.
• MOST50e for MOST50.

Select Tests Lets you select the tests you want to run. The tests are organized 
hierarchically so you can select all tests in a group. After tests are run, 
status indicators show which tests have passed, failed, or not been run, 
and there are indicators for the test groups.

Configure Lets you configure test parameters (for example, channels used in test, 
voltage levels, etc.).

Connect Shows you how to connect the oscilloscope to the device under test for 
the tests that are to be run.

Run Tests Starts the automated tests. If the connections to the device under test 
need to be changed while multiple tests are running, the tests pause, show 
you how to change the connection, and wait for you to confirm that the 
connections have been changed before continuing.

Automation Lets you construct scripts of commands that drive execution of the 
application.

Resul ts Contains more detailed information about the tests that have been run. You 
can change the thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.



17

 

Keysight N6466A/N6466B MOST Compliance Test Application 
Methods of Implementation

3 MOST 150 cPHY Tests

MOST 150 cPHY SP1 / 18
MOST 150 cPHY SP2 / 22
MOST 150 cPHY SP3 / 26
MOST 150 cPHY SP4 / 30

Figure 2 MOST 150 cPhy Simplex Interconnect

Figure 3 MOST 150 cPhy Duplex Interconnect
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3 MOST 150 cPHY Tests
 

MOST 150 cPHY SP1

This section provides the Methods of Implementation (MOIs) for the MOST 150c 
tests at test point SP1 using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example).

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST150 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 4 Probing for MOST150c SP1
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8 Click the Select Tests tab and check the SP1 tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Transferred Jitter - Jtr1" on page 20

• "Eye Mask - A1..H1" on page 20

MOST150c SP1
Specification

The MOST 150 cPHY specification defines transferred jitter and eye mask for SP1.

Figure 5 Selecting MOST150c SP1 Tests
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3 MOST 150 cPHY Tests
 

Transferred Jitter - Jtr1

The purpose of this test is to verify that the jitter that is transferred is below 50 ps 
RMS.

PASS Condition The standard deviation of the jitter is less than or equal to 50 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to constant frequency with semi-automatic data rate set 
to measurement from step 2.

4 Set TIE Filter to bandpass with start frequency = 10 Hz and stop frequency = 
200 kHz.

5 Perform TIE measurement on acquired signal.

6 Compare the standard deviation value with 50 ps.

Eye Mask - A1..H1

The purpose of this test is to verify that the signal at SP1 does not touch the 
"keep-out" zones of the mask.

PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).
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3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP1.
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3 MOST 150 cPHY Tests
 

MOST 150 cPHY SP2

This section provides the Methods of Implementation (MOIs) for the MOST 150c 
tests at test point SP2 using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST150 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 6 Probing for MOST150c SP2
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8 Click the Select Tests tab and check the SP2 tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Rise Time - tr2" on page 24

• "Fall Time - tf2" on page 24

• "Transferred Jitter - Jtr2" on page 25

• "Eye Mask - A2..H2" on page 25

MOST150c SP2
Specification

The MOST 150 cPHY specification defines rise time, fall time, transferred jitter and 
eye mask for SP2.

Figure 7 Selecting MOST150c SP2 Tests
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3 MOST 150 cPHY Tests
 Rise Time - tr2

The purpose of this test is to verify that the rise time, measured between 20% to 
80%, is greater than or equal to 700 ps and less than or equal to 1400 ps.

PASS Condition The rise time minimum and maximum values are greater than or equal to 700 ps 
and less than or equal to 1400 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up rise time measurement for 20% to 80% of the mean maximum and 
minimum voltage of the signal.

4 Perform rise time measurement on acquired signal.

5 Compare the minimum and maximum measured values are greater than or 
equal to 700 ps and less than or equal to 1400 ps.

Fall Time - tf2

The purpose of this test is to verify that the fall time, measured between 80% to 
20% is greater than or equal to 700 ps and less than or equal to 1400 ps.

PASS Condition The fall time minimum and maximum values are greater than or equal to 700 ps 
and less than or equal to 1400 ps.
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Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up fall time measurement for 80% to 20% of the mean maximum and 
minimum voltage of the signal.

4 Perform fall time measurement on acquired signal.

5 Compare the minimum and maximum measured values are greater than or 
equal to 700 ps and less than or equal to 1400 ps.

Transferred Jitter - Jtr2

The purpose of this test is to verify that the jitter that is transferred is below 112 ps 
RMS.

PASS Condition The standard deviation of the jitter is less than or equal to 112 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to constant frequency with semi-automatic data rate set 
to measurement from step 2.

4 Set TIE Filter to bandpass with start frequency = 10 Hz and stop frequency = 
200 kHz.

5 Perform TIE measurement on acquired signal.

6 Compare the standard deviation value with 112 ps.

Eye Mask - A2..H2

The purpose of this test is to verify that the signal at SP2 does not touch the 
"keep-out" zones of the mask.

PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP2.
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3 MOST 150 cPHY Tests
 

MOST 150 cPHY SP3

This section provides the Methods of Implementation (MOIs) for the MOST 150c 
tests at test point SP2 using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example).

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST150 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 8 Probing for MOST150c SP3
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8 Click the Select Tests tab and check the SP3 tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Rise Time - tr3" on page 27

• "Fall Time - tf3" on page 28

• "Transferred Jitter - Jtr3" on page 28

• "Eye Mask - A3..H3" on page 28

MOST150c SP3
Specification

The MOST 150 cPHY specification does not specify electrical tests for SP3, these 
are information only tests.

Rise Time - tr3

The purpose of this test is to report the rise time value of the signal at SP3 
(measured from 20%-80%).

PASS Condition Information only test.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up rise time measurement for 20% to 80% of the mean maximum and 
minimum voltage of the signal.

Figure 9 Selecting MOST150c SP3 Tests
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3 MOST 150 cPHY Tests
 

4 Perform rise time measurement on acquired signal.

5 Report value as information only.

Fall Time - tf3

The purpose of this test is to report the fall time value of the signal at SP3 
(measured from 80% to 20%).

PASS Condition Information only test.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up fall time measurement for 80% to 20% of the mean maximum and 
minimum voltage of the signal.

4 Perform fall time measurement on acquired signal.

5 Report value as information only.

Transferred Jitter - Jtr3

The purpose of this test is to report the transferred jitter value of the signal at SP3.

PASS Condition Information only test.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to constant frequency with semi-automatic data rate set 
to measurement from step 2.

4 Set TIE Filter to bandpass with start frequency = 10 Hz and stop frequency = 
200 kHz.

5 Perform TIE measurement on acquired signal.

6 Compare the standard deviation value with 112 ps.

Eye Mask - A3..H3

The purpose of this test is to report the eye of the signal at SP3.

PASS Condition Information only test.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.
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4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP2.
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3 MOST 150 cPHY Tests
 

MOST 150 cPHY SP4

This section provides the Methods of Implementation (MOIs) for the MOST 150c 
tests at test point SP4 using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST150 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 10 Probing for MOST150c SP4
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8 Click the Select Tests tab and check the SP4 tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Transferred Jitter - Jtr4" on page 32

• "Eye Mask - A4..H4" on page 32

MOST150c SP4
Specification

The MOST 150 cPHY specification defines transferred jitter and eye mask for SP4.

Figure 11 Selecting MOST150c SP4 Tests
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3 MOST 150 cPHY Tests
 

Transferred Jitter - Jtr4

The purpose of this test is to verify that the jitter that is transferred is below 230 ps 
RMS.

PASS Condition The standard deviation of the jitter is less than or equal to 230 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to constant frequency with semi-automatic data rate set 
to measurement from step 2.

4 Set TIE Filter to bandpass with start frequency = 10 Hz and stop frequency = 
200 kHz.

5 Perform TIE measurement on acquired signal.

6 Compare the standard deviation value with 230 ps.

Eye Mask - A4..H4

The purpose of this test is to verify that the signal at SP4 does not touch the 
"keep-out" zones of the mask.
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PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP4.
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Figure 12 MOST150 oPhy Interconnect
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MOST 150 oPHY SP1

This section provides the Methods of Implementation (MOIs) for the MOST 150o 
tests at test point SP1 using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST150 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 13 Probing for MOST150o SP1
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8 Click the Select Tests tab and check the SP1 tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Transferred Jitter - Jtr1" on page 38

• "Eye Mask - A1..H1" on page 38

MOST150o SP1
Specification

The MOST 150 oPHY specification defines transferred jitter and eye mask for SP1.

Figure 14 Selecting MOST150o SP1 Tests
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Transferred Jitter - Jtr1

The purpose of this test is to verify that the jitter that is transferred is below 50 ps 
RMS.

PASS Condition The standard deviation of the jitter is less than or equal to 50 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to constant frequency with semi-automatic data rate set 
to measurement from step 2.

4 Set TIE Filter to bandpass with start frequency = 10 Hz and stop frequency = 
200 kHz.

5 Perform TIE measurement on acquired signal.

6 Compare the standard deviation value with 50 ps.

Eye Mask - A1..H1

The purpose of this test is to verify that the signal at SP1 does not touch the 
"keep-out" zones of the mask.

PASS Condition The signal does not touch or go into the mask.
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Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP1.
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MOST 150 oPHY SP2

This section provides the Methods of Implementation (MOIs) for the MOST 150o 
tests at test point SP2 using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST150 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 15 Probing for MOST150o SP2
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8 Click the Select Tests tab and check the SP2 tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Rise Time - tr2" on page 44

• "Fall Time - tf2" on page 45

• "Transferred Jitter - Jtr2" on page 45

• "Eye Mask - A2..E2" on page 46

• "Overshoot - Ao..Ko" on page 46

• "Undershoot - Au..Ku" on page 46

• "Extinction Ratio" on page 47

MOST150c SP2
Specification

The MOST 150 oPHY specification defines rise time, fall time, transferred jitter, eye 
mask, overshoot, undershoot, and extinction ratio for SP2.

Figure 16 Selecting MOST150o SP2 Tests
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Rise Time - tr2

The purpose of this test is to verify that the rise time, measured between 20% to 
80%, is less than or equal to 0.5 UI.

PASS Condition The rise time maximum value is less than or equal to 0.5 UI.
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Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up rise time measurement for 20% to 80% of the mean maximum and 
minimum voltage of the signal.

4 Perform rise time measurement on acquired signal.

5 Compare the maximum value to 0.5 UI (UI is defined by the measurement in 
step 2).

Fall Time - tf2

The purpose of this test is to verify that the fall time, measured between 80% to 
20% is less than or equal to 0.5 UI.

PASS Condition The fall time maximum value is less than or equal to 0.5 UI.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up fall time measurement for 80% to 20% of the mean maximum and 
minimum voltage of the signal.

4 Perform fall time measurement on acquired signal.

5 Compare the maximum value to 0.5 UI (UI is defined by the measurement in 
step 2).

Transferred Jitter - Jtr2

The purpose of this test is to verify that the jitter that is transferred is below 112 ps 
RMS.

PASS Condition The standard deviation of the jitter is less than or equal to 112 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to constant frequency with semi-automatic data rate set 
to measurement from step 2.

4 Set TIE Filter to bandpass with start frequency = 10 Hz and stop frequency = 
200 kHz.

5 Perform TIE measurement on acquired signal.

6 Compare the standard deviation value with 112 ps.
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Eye Mask - A2..E2

The purpose of this test is to verify that the signal at SP2 does not touch the 
"keep-out" zones of the mask.

PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP2.

Overshoot - Ao..Ko

The purpose of this test is to verify that the signal at SP2 does not touch the 
"keep-out" zones of the overshoot mask.

PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up to trigger on the rising edge of the signal.

4 Scale rising edge triggered data to fit the overshoot mask to the screen and 
capture 100 acquisitions.

5 Compare the signal to the overshoot mask defined for SP2.

Undershoot - Au..Ku

The purpose of this test is to verify that the signal at SP2 does not touch the 
"keep-out" zones of the undershoot mask.

PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up to trigger on the rising edge of the signal.

4 Scale rising edge triggered data to fit the overshoot mask to the screen and 
capture 100 acquisitions.

5 Compare the signal to the undershoot mask defined for SP2.
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Extinction Ratio

The purpose of this test is to verify that the Extinction Ratio at SP2 is greater than 
10 dB.

PASS Condition The measured high level and low level ratio 10 *Log((B1-DL) / (B0-DL)) is greater 
than 10 dB.

Measurement
Algorithm

1 Measure the voltage of the dark level for dark level calibration by blocking the 
optical probe input. The mean voltage is DL.

2 Input the MOST signal to the optical probe.

3 Set up to trigger on 5 to 6 UI of the high signal.

4 Measure the high signal with histogram between tOSLS and tOSLE. The mean 
value is B1.

5 Set up to trigger on 5 to 6 UI of the low signal.

6 Measure the low signal with histogram between tOSLS and tOSLE. The mean 
value is B0.

7 Calculate the extinction ratio with 10 *Log((B1-DL) / (B0-DL)).

NOTE Extinction Ratio can only be measured with a DC-coupled optical probe. It cannot be measured 
with an AC-coupled optical probe.
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MOST 150 oPHY SP3

This section provides the Methods of Implementation (MOIs) for the MOST 150o 
tests at test point SP3 using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST150 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 17 Probing for MOST150o SP3
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8 Click the Select Tests tab and check the SP3 tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Rise Time - tr3" on page 49

• "Fall Time - tf3" on page 50

• "Transferred Jitter - Jtr3" on page 50

• "Eye Mask - A3..E3" on page 50

• "Overshoot - Ao..Ko" on page 51

• "Undershoot - Au..Ku" on page 51

MOST150c SP3
Specification

The MOST 150 oPHY specification does not specify electrical tests for SP3, these 
are information only tests.

Rise Time - tr3

The purpose of this test is to report the rise time value of the signal at SP3 
(measured from 20%-80%).

PASS Condition Information only test.

Figure 18 Selecting MOST150o SP3 Tests
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Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up rise time measurement for 20% to 80% of the mean maximum and 
minimum voltage of the signal.

4 Perform rise time measurement on acquired signal.

5 Report value as information only.

Fall Time - tf3

The purpose of this test is to report the fall time value of the signal at SP3 
(measured from 80% to 20%).

PASS Condition Information only test.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up fall time measurement for 80% to 20% of the mean maximum and 
minimum voltage of the signal.

4 Perform fall time measurement on acquired signal.

5 Report value as information only.

Transferred Jitter - Jtr3

The purpose of this test is to report the transferred jitter value of the signal at SP3.

PASS Condition Information only test.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to constant frequency with semi-automatic data rate set 
to measurement from step 2.

4 Set TIE Filter to bandpass with start frequency = 10 Hz and stop frequency = 
200 kHz.

5 Perform TIE measurement on acquired signal.

6 Compare the standard deviation value with 112 ps.

Eye Mask - A3..E3

The purpose of this test is to report the eye of the signal at SP3.

PASS Condition Information only test.
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Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP2.

Overshoot - Ao..Ko

The purpose of this test is to report the overshoot of the signal at SP3.

PASS Condition Information only test.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up to trigger on the rising edge of the signal.

4 Scale rising edge triggered data to fit the overshoot mask to the screen and 
capture 100 acquisitions.

5 Compare the signal to the overshoot mask defined for SP2.

Undershoot - Au..Ku

The purpose ofthis test is to report the undershoot of the signal at SP3.

PASS Condition Information only test.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up to trigger on the rising edge of the signal.

4 Scale rising edge triggered data to fit the overshoot mask to the screen and 
capture 100 acquisitions.

5 Compare the signal to the undershoot mask defined for SP2.
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MOST 150 oPHY SP4

This section provides the Methods of Implementation (MOIs) for the MOST 150o 
tests at test point SP4 using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST150 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 19 Probing for MOST150o SP4



MOST 150 oPHY Tests 4

Keysight N6466A/N6466B MOST Compliance Test Application Methods of Implementation 53

 

8 Click the Select Tests tab and check the SP4 tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Transferred Jitter - Jtr4" on page 54

• "Eye Mask - A4..H4" on page 55

MOST150o SP4
Specification

The MOST 150 oPHY specification defines transferred jitter and eye mask for SP4.

Figure 20 Selecting MOST150o SP4 Tests
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Transferred Jitter - Jtr4

The purpose of this test is to verify that the jitter that is transferred is below 230 ps 
RMS.

PASS Condition The standard deviation of the jitter is less than or equal to 230 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to constant frequency with semi-automatic data rate set 
to measurement from step 2.

4 Set TIE Filter to bandpass with start frequency = 10 Hz and stop frequency = 
200 kHz.

5 Perform TIE measurement on acquired signal.

6 Compare the standard deviation value with 230 ps.
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Eye Mask - A4..H4

The purpose of this test is to verify that the signal at SP4 does not touch the 
"keep-out" zones of the mask.

PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP4.
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MOST 50 SP1E

This section provides the Methods of Implementation (MOIs) for the MOST 50 tests 
at test point SP1E using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST50 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 21 Probing for MOST50 at SP1E
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8 Click the Select Tests tab and check the SP1E tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Transferred Jitter" on page 60

• "Eye Mask - A..D" on page 60

MOST50 SP1E
Specification

The MOST 50 ePHY specification defines transferred jitter (140 ps RMS max) and 
eye mask for SP1E.

Figure 22 Selecting MOST50 SP1E Tests
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Transferred Jitter

The purpose of this test is to verify that the jitter that is transferred is below 140 ps 
RMS.

PASS Condition The standard deviation of the jitter is less than or equal to 140 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to constant frequency with semi-automatic data rate set 
to measurement from step 2.

4 Set TIE Filter to bandpass with start frequency = 10 Hz and stop frequency = 
200 kHz.

5 Perform TIE measurement on acquired signal.

6 Compare the standard deviation value with 140 ps.

Eye Mask - A..D

The purpose of this test is to verify that the signal at SP1E does not touch the 
"keep-out" zones of the mask.

PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP1E.
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MOST 50 SP2E

This section provides the Methods of Implementation (MOIs) for the MOST 50 tests 
at test point SP2E using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST50 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 23 Probing for MOST50 at SP2E
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8 Click the Select Tests tab and check the SP2E tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Transferred Jitter" on page 63

• "Eye Mask - A..D" on page 63

MOST50 SP2E
Specification

The MOST 50 ePHY specification defines transferred jitter (150 ps RMS max) and 
eye mask for SP2E.

Figure 24 Selecting MOST50 SP2E Tests
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Transferred Jitter

The purpose of this test is to verify that the jitter that is transferred is below 150 ps 
RMS.

PASS Condition The standard deviation of the jitter is less than or equal to 150 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to constant frequency with semi-automatic data rate set 
to measurement from step 2.

4 Set TIE Filter to bandpass with start frequency = 10 Hz and stop frequency = 
200 kHz.

5 Perform TIE measurement on acquired signal.

6 Compare the standard deviation value with 150 ps.

Eye Mask - A..D

The purpose of this test is to verify that the signal at SP2E does not touch the 
"keep-out" zones of the mask.

PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP2E.
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MOST 50 SP3E

This section provides the Methods of Implementation (MOIs) for the MOST 50 tests 
at test point SP3E using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST50 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 25 Probing for MOST50 at SP3E
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8 Click the Select Tests tab and check the SP3E tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Eye Mask - A..D" on page 65

MOST50 SP3E
Specification

The MOST 50 ePHY specification defines eye mask for SP3E.

Eye Mask - A..D

The purpose of this test is to verify that the signal at SP3E does not touch the 
"keep-out" zones of the mask.

Figure 26 Selecting MOST50 SP3E Tests
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PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP3E.
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MOST 50 SP4E

This section provides the Methods of Implementation (MOIs) for the MOST 50 tests 
at test point SP4E using a Keysight Infiniium oscilloscope and the 
N6466A/N6466B MOST Compliance Test Application.

Probing and
Connection

You can use any of the oscilloscope channels as Pin Under Test (PUT) source 
channel. You can identify the channels used for each signal in the Configuration tab 
of the MOST Compliance Test Application. (The channel shown in the previous 
figure is just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the MOST 
Compliance Test Application" on page 15.

2 Ensure that the MOST Device Under Test (DUT) is on and set up for MOST50 
testing.

3 Connect the probes to the Pin Under Test (PUT) on the MOST DUT.

4 Connect the oscilloscope probes to the channel of the oscilloscope that you 
have set up in the Configuration tab.

5 In the MOST Test application, click the Set Up tab.

6 Select the MOST Spec that you plan to test.

7 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 27 Probing for MOST50 at SP4E
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8 Click the Select Tests tab and check the SP4E tests you want to run. Check the 
parent node or group to check all the available tests within the group.

• "Eye Mask - A..D" on page 68

MOST50 SP4E
Specification

The MOST 50 ePHY specification defines eye mask for SP4E.

Eye Mask - A..D

The purpose of this test is to verify that the signal at SP4E does not touch the 
"keep-out" zones of the mask.

PASS Condition The signal does not touch or go into the mask.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the data rate and set the memory depth to capture 100 frames (3072 
bits per frame).

3 Set up clock recovery to first order PLL. Nominal Data Rate = Value from step 2. 
Loop Bandwidth = 125 kHz.

Figure 28 Selecting MOST50 SP4E Tests
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4 Fold data and scale eye to fit one eye into the oscilloscope capture screen.

5 Compare the signal to the mask defined for SP4E.
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Keysight N6466A/N6466B MOST Compliance Test Application 
Methods of Implementation

A Calibrating the Infiniium 
Oscilloscope and Probe

Oscilloscope Internal Calibration / 72
Probe Calibration / 77

This section describes the Keysight Infiniium digital storage oscilloscope 
calibration procedures.
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Oscilloscope Internal Calibration

This will perform an internal diagnostic and calibration cycle for the oscilloscope. 
For the Keysight oscilloscope, this is referred to as Calibration.

Required Equipment for Oscilloscope Calibration

To calibrate the Infiniium oscilloscope in preparation for running the MOST 
automated tests, you need the following equipment:

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Precision 3.5 mm BNC to SMA male adapter, Keysight p/n 54855-67604, 
qty = 2 (provided with the Keysight Infiniium oscilloscope).

• Calibration cable (provided with Keysight Infiniium oscilloscopes). Use a good 
quality 50 Ω BNC cable.

• BNC shorting cap.

Figure 29 Accessories Provided with the Keysight Infiniium Oscilloscope

BNC
Shorting Cap
(Used to calibrate
54850A series
oscilloscopes)

Precision 3.5 mm Adapters (2)

Calibration Cable
(Used to calibrate 54850A,
Keysight Infiniium
oscilloscopes)
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Running the Oscilloscope Internal Calibration

This Calibration will take about 20 minutes. Perform the following steps:

1 Set up the oscilloscope with the following steps:

a Connect the keyboard, mouse, and power cord to the rear of the 
oscilloscope.

b Plug in the power cord.

c Turn on the oscilloscope by pressing the power button located on the lower 
left of the front panel.

d Allow the oscilloscope to warm up at least 30 minutes prior to starting the 
calibration procedure in step 3 below.

2 Locate and prepare the accessories that will be required for the internal 
calibration:

a Locate the BNC shorting cap.

b Locate the calibration cable.

c Locate the two Keysight precision SMA/BNC adapters.

d Attach one SMA adapter to the other end of the calibration cable - hand 
tighten snugly.

e Attach another SMA adapter to the other end of the calibration cable - hand 
tighten snugly.
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3 Referring to the following figure, perform the following steps:

a Click the Util ities > Calibration... menu to open the Calibration dialog box.

4 Referring to the following figure, perform the following steps to start the 
calibration:

Figure 30 Accessing the Calibration Menu
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a Uncheck the Cal Memory Protect checkbox.

b Click the Start button to begin the calibration.

c During the calibration of channel 1, if you are prompted to perform a Time 
Scale Calibration, as shown in the following figure, click the Std+Dfl t button to 
continue the calibration, using the Factory default calibration factors.

Figure 31 Oscilloscope Calibration Window
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d When the calibration procedure is complete, you will be prompted with a 
Calibration Complete message window. Click the OK button to close this 
window.

e Confirm that the Vertical and Trigger Calibration Status for all Channels 
passed.

f Click the Close button to close the calibration window.

g The internal calibration is completed.

Figure 32 Time Scale Calibration Dialog Box

NOTE These steps do not need to be performed every time a test is run. However, if the ambient 
temperature changes more than 5 degrees Celsius from the calibration temperature, this 
calibration should be performed again. The delta between the calibration temperature and the 
present operating temperature is shown in the Util ities > Calibration... menu.
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Probe Calibration

Before performing MOST tests, you should calibrate the probes. Calibration of the 
solder-in probe heads consist of a vertical calibration and a skew calibration. The 
vertical calibration should be performed before the skew calibration. Both 
calibrations should be performed for best probe measurement performance.

Required Equipment for Probe Calibration

The calibration procedure requires the following parts.

• BNC (male) to SMA (male) adapter.

• Deskew fixture.

• 50 Ω SMA terminator.

Connecting the Probe for Calibration

For the following procedure, refer to the following figure.
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1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the 
connector closest to the yellow pincher.

2 Connect the 50 Ω SMA terminator to the connector farthest from yellow 
pincher.

Figure 33 Solder-in Probe Head Calibration Connection Example

BNC to SMA
Connector

Pincher

50 Ω SMA
Terminator

Deskew
Fixture
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3 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium 
oscilloscope.

4 Connect the probe to an oscilloscope channel.

5 To minimize the wear and tear on the probe head, it should be placed on a 
support to relieve the strain on the probe head cables.

6 Push down the back side of the yellow pincher. Insert the probe head resistor 
lead underneath the center of the yellow pincher and over the center conductor 
of the deskew fixture. The negative probe head resistor lead or ground lead 
must be underneath the yellow pincher and over one of the outside copper 
conductors (ground) of the deskew fixture. Make sure that the probe head is 
approximately perpendicular to the deskew fixture.

7 Release the yellow pincher.

Verifying the Connection

1 On the Infiniium oscilloscope, press the [Auto Scale] key on the front panel.

2 Set the volts per division to 100 mV/d iv.

3 Set the horizontal scale to 1.00 ns/d iv.

4 Set the horizontal position to approximately 3 ns. You should see a waveform 
similar to that in the following figure.

If you see a waveform similar to that of the following figure, then you have a bad 
connection and should check all of your probe connections.

Figure 34 Good Connection Waveform Example
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Figure 35 Bad Connection Waveform Example
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Running the Probe Calibration and Deskew

1 On the Infiniium oscilloscope in the Setup menu, select the channel connected 
to the probe, as shown in the following figure.

2 In the Channel Setup dialog box, select the Probes... button, as shown in the 
following figure.

Figure 36 Channel Setup Window
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3 In the Probe Setup dialog box, select the Calibrate Probe... button.

4 In the Probe Calibration dialog box, select the Calibrated Atten/Offset radio 
button.

5 Select the Start Atten/Offset Calibration... button and follow the on-screen 
instructions for the vertical calibration procedure.

Figure 37 Channel Dialog Box

Figure 38 Probe Setup Window
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6 Once the vertical calibration has successfully completed, select the Calibrated 
Skew... button.

7 Select the Start Skew Cal ibration... button and follow the on-screen instructions 
for the skew calibration.

At the end of each calibration, the oscilloscope will prompt you if the calibration 
was or was not successful.

Verifying the Probe Calibration

If you have successfully calibrated the probe, it is not necessary to perform this 
verification. However, if you want to verify that the probe was properly calibrated, 
the following procedure will help you verify the calibration.

The calibration procedure requires the following parts:

• BNC (male) to SMA (male) adapter.

• SMA (male) to BNC (female) adapter.

• BNC (male) to BNC (male) 12 inch cable such as the Keysight 8120-1838.

• Keysight 54855-61620 calibration cable (Infiniium oscilloscopes with 
bandwidths of 6 GHz and greater only).

• Keysight 54855-67604 precision 3.5 mm adapters (Infiniium oscilloscopes with 
bandwidths of 6 GHz and greater only).

• Deskew fixture.

For the following procedure, refer to the following figure.

Figure 39 Probe Calibration Window
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1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the 
connector closest to the yellow pincher.

2 Connect the SMA (male) to BNC (female) to the connector farthest from the 
yellow pincher.

Figure 40 Probe Calibration Verification Connection Example
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3 Connect the BNC (male) to BNC (male) cable to the BNC connector on the 
deskew fixture to one of the unused oscilloscope channels. For infiniium 
oscilloscopes with bandwidths of 6 GHz and greater, use the 54855-61620 
calibration cable and the two 54855-64604 precision 3.5 mm adapters.

4 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium 
oscilloscope.

5 Connect the probe to an oscilloscope channel.

6 To minimize the wear and tear on the probe head, it should be placed on a 
support to relieve the strain on the probe head cables.

7 Push down on the back side of the yellow pincher. Insert the probe head 
resistor lead underneath the center of the yellow pincher and over the center 
conductor of the deskew fixture. The negative probe head resistor lead or 
ground lead must be underneath the yellow pincher and over one of the outside 
copper conductors (ground) of the deskew fixture. Make sure that the probe 
head is approximately perpendicular to the deskew fixture.

8 Release the yellow pincher.

9 On the oscilloscope, press the autoscale button on the front panel.

10 Select Setup menu and choose the channel connected to the BNC cable from 
the pull-down menu.

11 Select the Probes... button.

12 Select the Configure Probe System button.

13 Select User Defined Probe from the pull-down menu.

14 Select the Calibrate Probe... button.

15 Select the Calibrated Skew radio button.

16 Once the skew calibration is completed, close all dialog boxes.

17 Select the Start Skew Cal ibration... button and follow the on-screen instructions.

18 Set the vertical scale for the displayed channels to 100 mV/d iv.

19 Set the horizontal range to 1.00 ns/d iv.

20 Set the horizontal position to approximately 3 ns.

21 Change the vertical position knobs of both channels until the waveforms 
overlap each other.

22 Select the Setup menu choose Acquisition... from the pull-down menu.

23 In the Acquisition Setup dialog box enable averaging. When you close the 
dialog box, you should see waveforms similar to that in the following figure.
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Figure 41 Calibration Probe Waveform Example

NOTE Each probe is calibrated with the oscilloscope channel to which it is connected. Do not switch 
probes between channels or other oscilloscopes, or it will be necessary to calibrate them 
again. It is recommended that the probes be labeled with the channel on which they were 
calibrated.



Keysight N6466A/N6466B MOST Compliance Test Application Methods of Implementation 87

 

Index

Numerics

1130A InfiniiMax1.5 GHz differential probe 
amplifier, 3

A

AC-coupled optical-to-electrical 
converter, 3

application software, installing, 10
application software, starting, 15
Automation tab, 16

B

BNC shorting cap, 72
BNC to SMA male adapter, 72

C

calibrating the oscilloscope, 14, 71
calibration cable, 72
Configure tab, 16
Connect tab, 16

D

DC-coupled optical-to-electrical 
converter, 3

deskew and probe calibration, running, 81

E

E2678A socketed probe head with damping 
resistor, 3

equipment required for calibration, 72
equipment required for probe 

calibration, 77
Extinction Ratio, SP2, 47
Eye Mask - A..D, MOST 50 SP1E, 60
Eye Mask - A..D, MOST 50 SP2E, 63
Eye Mask - A..D, MOST 50 SP3E, 65
Eye Mask - A..D, MOST 50 SP4E, 68
Eye Mask - A1..H1, MOST 150 cPHY, 20
Eye Mask - A1..H1, MOST 150 oPHY, 38
Eye Mask - A2..E2, MOST 150 oPHY, 46
Eye Mask - A2..H2, MOST 150 cPHY, 25

Eye Mask - A3..E3, MOST 150 oPHY, 50
Eye Mask - A3..H3, MOST 150 cPHY, 28
Eye Mask - A4..H4, MOST 150 cPHY, 32
Eye Mask - A4..H4, MOST150o, 55

F

Fall Time - tf2, MOST 150 cPHY, 24
Fall Time - tf2, MOST 150 oPHY, 45
Fall Time - tf3, MOST 150 cPHY, 28
Fall Time - tf3, MOST 150 oPHY, 50

H

HTML Report tab, 16

I

installation, 9

K

keyboard, 72

L

license key, installing, 11

M

measurements, preparing, 13
MOST 150 coax, 3
MOST 150 cPHY SP1 measurements, 18
MOST 150 cPHY SP2 measurements, 22
MOST 150 cPHY SP3 measurements, 26
MOST 150 cPHY SP4 measurements, 30
MOST 150 oPHY SP1 measurements, 36
MOST 150 oPHY SP2 measurements, 40
MOST 150 oPHY SP3 measurements, 48
MOST 150 oPHY SP4 measurements, 52
MOST 150 optical, 3
MOST 50, 3
MOST 50 SP1E measurements, 58
MOST 50 SP2E measurements, 61
MOST 50 SP3E measurements, 64
MOST 50 SP4E measurements, 67

MOST compliance test application, 3
MOST150c SP1 specification, 19
MOST150c SP2 specification, 23
MOST150c SP3 specification, 27
MOST150c SP4 specification, 31
MOST150o SP1 specification, 37
MOST150o SP2 specification, 41
MOST150o SP3 specification, 49
MOST150o SP4 specification, 53
MOST50 SP1E specification, 59
MOST50 SP2E specification, 62
MOST50 SP3E specification, 65
MOST50 SP4E specification, 68
mouse, 72

N

N2750A InfiniiMode 1.5 GHz active 
differential probe, 3

notices, 3

O

OEC (optical-to-electrical converter), 3
optical-to-electrical converter (OEC), 3
oscilloscope calibration, 14
oscilloscope internal calibration, 72
oscilloscope internal calibration, 

running, 73
Overshoot - Ao..Ko, SP2, 46
Overshoot - Ao..Ko, SP3, 51

P

precision 3.5 mm BNC to SMA male 
adapter, 72

probe calibration, 77
probe calibration and deskew, running, 81
probe calibration connection, verifying, 79
probe calibration, connecting, 77
probe calibration, verifying, 83

R

Results tab, 16
Rise Time - tr2, MOST 150 cPHY, 24
Rise Time - tr2, MOST 150 oPHY, 44
Rise Time - tr3, MOST 150 cPHY, 27



88 Keysight N6466A/N6466B MOST Compliance Test Application Methods of Implementation

Index
 

Rise Time - tr3, MOST 150 oPHY, 49
Run Tests tab, 16

S

Select Tests tab, 16
Set Up tab, 16
specification, MOST150c SP1, 19
specification, MOST150c SP2, 23
specification, MOST150c SP3, 27
specification, MOST150c SP4, 31
specification, MOST150o SP1, 37
specification, MOST150o SP2, 41
specification, MOST150o SP3, 49
specification, MOST150o SP4, 53
specification, MOST50 SP1E, 59
specification, MOST50 SP2E, 62
specification, MOST50 SP3E, 65
specification, MOST50 SP4E, 68

T

Transferred Jitter - Jtr1, MOST 150 
cPHY, 20

Transferred Jitter - Jtr1, MOST 150 
oPHY, 38

Transferred Jitter - Jtr2, MOST 150 
cPHY, 25

Transferred Jitter - Jtr2, MOST 150 
oPHY, 45

Transferred Jitter - Jtr3, MOST 150 
cPHY, 28

Transferred Jitter - Jtr3, MOST 150 
oPHY, 50

Transferred Jitter - Jtr4, MOST 150 
cPHY, 32

Transferred Jitter - Jtr4, MOST150o, 54
Transferred Jitter, MOST 50 SP1E, 60
Transferred Jitter, MOST 50 SP2E, 63

U

Undershoot - Au..Ku, SP2, 46
Undershoot - Au..Ku, SP3, 51


	MOST Compliance Test Application—At a Glance
	Contents
	Installing the MOST Compliance Test Application
	Installing the Software
	Installing the License Key

	Preparing to Take Measurements
	Calibrating the Oscilloscope
	Starting the MOST Compliance Test Application
	Figure 1 MOST Compliance Test Application Main Window


	MOST 150 cPHY Tests
	Figure 2 MOST 150 cPhy Simplex Interconnect
	Figure 3 MOST 150 cPhy Duplex Interconnect
	MOST 150 cPHY SP1
	Figure 4 Probing for MOST150c SP1
	Figure 5 Selecting MOST150c SP1 Tests
	Transferred Jitter - Jtr1
	Eye Mask - A1..H1

	MOST 150 cPHY SP2
	Figure 6 Probing for MOST150c SP2
	Figure 7 Selecting MOST150c SP2 Tests
	Rise Time - tr2
	Fall Time - tf2
	Transferred Jitter - Jtr2
	Eye Mask - A2..H2

	MOST 150 cPHY SP3
	Figure 8 Probing for MOST150c SP3
	Figure 9 Selecting MOST150c SP3 Tests
	Rise Time - tr3
	Fall Time - tf3
	Transferred Jitter - Jtr3
	Eye Mask - A3..H3

	MOST 150 cPHY SP4
	Figure 10 Probing for MOST150c SP4
	Figure 11 Selecting MOST150c SP4 Tests
	Transferred Jitter - Jtr4
	Eye Mask - A4..H4


	MOST 150 oPHY Tests
	Figure 12 MOST150 oPhy Interconnect
	MOST 150 oPHY SP1
	Figure 13 Probing for MOST150o SP1
	Figure 14 Selecting MOST150o SP1 Tests
	Transferred Jitter - Jtr1
	Eye Mask - A1..H1

	MOST 150 oPHY SP2
	Figure 15 Probing for MOST150o SP2
	Figure 16 Selecting MOST150o SP2 Tests
	Rise Time - tr2
	Fall Time - tf2
	Transferred Jitter - Jtr2
	Eye Mask - A2..E2
	Overshoot - Ao..Ko
	Undershoot - Au..Ku
	Extinction Ratio

	MOST 150 oPHY SP3
	Figure 17 Probing for MOST150o SP3
	Figure 18 Selecting MOST150o SP3 Tests
	Rise Time - tr3
	Fall Time - tf3
	Transferred Jitter - Jtr3
	Eye Mask - A3..E3
	Overshoot - Ao..Ko
	Undershoot - Au..Ku

	MOST 150 oPHY SP4
	Figure 19 Probing for MOST150o SP4
	Figure 20 Selecting MOST150o SP4 Tests
	Transferred Jitter - Jtr4
	Eye Mask - A4..H4


	MOST 50 Tests
	MOST 50 SP1E
	Figure 21 Probing for MOST50 at SP1E
	Figure 22 Selecting MOST50 SP1E Tests
	Transferred Jitter
	Eye Mask - A..D

	MOST 50 SP2E
	Figure 23 Probing for MOST50 at SP2E
	Figure 24 Selecting MOST50 SP2E Tests
	Transferred Jitter
	Eye Mask - A..D

	MOST 50 SP3E
	Figure 25 Probing for MOST50 at SP3E
	Figure 26 Selecting MOST50 SP3E Tests
	Eye Mask - A..D

	MOST 50 SP4E
	Figure 27 Probing for MOST50 at SP4E
	Figure 28 Selecting MOST50 SP4E Tests
	Eye Mask - A..D


	Calibrating the Infiniium Oscilloscope and Probe
	Oscilloscope Internal Calibration
	Required Equipment for Oscilloscope Calibration
	Figure 29 Accessories Provided with the Keysight Infiniium Oscilloscope

	Running the Oscilloscope Internal Calibration
	Figure 30 Accessing the Calibration Menu
	Figure 31 Oscilloscope Calibration Window
	Figure 32 Time Scale Calibration Dialog Box


	Probe Calibration
	Required Equipment for Probe Calibration
	Connecting the Probe for Calibration
	Figure 33 Solder-in Probe Head Calibration Connection Example

	Verifying the Connection
	Figure 34 Good Connection Waveform Example
	Figure 35 Bad Connection Waveform Example

	Running the Probe Calibration and Deskew
	Figure 36 Channel Setup Window
	Figure 37 Channel Dialog Box
	Figure 38 Probe Setup Window
	Figure 39 Probe Calibration Window

	Verifying the Probe Calibration
	Figure 40 Probe Calibration Verification Connection Example
	Figure 41 Calibration Probe Waveform Example



	Index

